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1. About Kernel for Novell GroupWise to Exchange

Welcome to the user manual for Kernel for Novell GroupWise to Exchange, result oriented and effective
email migration software that helps you to migrate from Novell GroupWise to MS Exchange Server. It
easily exports user mailboxes, calendar, tasks, trash items, sent items, documents, checklist, work in
progress, cabinet, Unicode characters, journals, notes, archives, personal address books and all the
existing folders from GroupWise mailboxes and stores them in the user's new mailboxes on MS Exchange
Server or to Personal Storage Files(.PST).

Kernel for Novell GroupWise to Exchange software provides secure migration to MS Exchange Server.
Users can migrate Single GroupWise Mailbox or Unlimited GroupWise Mailboxes at once.

This user manual comprises step by step guidelines on using Kernel for Novell GroupWise to Exchange.

1.1 Using this Manual

This user manual is intended to guide users on using Kernel for Novell GroupWise to Exchange. We
suggest that first time users should read this user manual completely and carefully before proceeding to
use the software. However, if you are an experienced user, you can use the table of contents to find out
information pertaining to the tasks that you need to perform by using Kernel for Novell GroupWise to
Exchange. You can use the table of contents to navigate through different sections of this user manual.
The table of contents lists all the sections that are contained in this user manual in chronological order.
The user manual comprises the following sections:

e About Kernel for Novell GroupWise to Exchange

o Getting Started

o Migration from Novell GroupWise to Exchange Server

e Advance Options to Make the Migration More Efficient

¢ Difference between Evaluation and Full Version

e Purchase and Support

e Legal Notices

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual.

1.1.1 List of Abbreviations
PST: Personal Storage Files
XLS: Excel Sheet Extension

MS: Microsoft
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RAM: Random Access Memory

MB: Mega-Byte

GB: Giga-Byte

1.2 Who should use this Software?

The capability and potential of Kernel for Novell GroupWise to Exchange software to perform the migration
smoothly and accurately makes it the preferred and best choice for organizations that want to switch from
Novell GroupWise to MS Exchange Server, which generally takes days and hours to complete.

The software is also helpful to Administrators and Technicians, who need to perform migration from Novell
GroupWise Server to Microsoft Exchange Server, so their organizations can avail the advance
functionalities of MS Outlook which is used in collaboration with MS Exchange Server. The need of
migration from Novell GroupWise to MS Exchange Server arises due to accessibility issues, server
maintenance charges, security reasons and increased help desk cost associated with Novell GroupWise
server.

1.3 Introduction

Once you download the software setup of Kernel for Novell GroupWise to Exchange, two applications get
installed on your system. One is the main application — Kernel for Novell GroupWise to Exchange software
and second is a batch file creation tool — Kernel for Novell GroupWise to Exchange Migration File Creator.
Both the applications are discussed below.

1.3.1 Kernel for Novell GroupWise to Exchange

Kernel for Novell GroupWise to Exchange is an advanced and result oriented email migration software
that easily exports every item of GroupWise User Mailbox i.e. emails, contacts, calendars, sent items,
trash items, documents, check list, Unicode characters, cabinet, work in progress, journals, notes,
appointments, archive items, etc.

Two choices are available to the user for migration - Single Mailbox Migration and Multiple Mailboxes

Migration. Single Mailbox Migration option converts one mailbox at a time whereas Multiple Mailboxes
Migration option converts unlimited mailboxes at a time.

1.3.1.1 Salient Features
¢ Migrates from GroupWise to Exchange
e Converts Single GroupWise Mailbox
e Converts Batch of GroupWise Mailboxes
e Baich file migration through imported MS Excel worksheets
e Migrates archived GroupWise items
e Migrates complete Address Books
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e Migrates securely and accurately

e Saves converted mailboxes in PST or MS Exchange Server user profile

e Supports every version of Novell GroupWise, MS Exchange Server, MS Excel and MS Outlook
o Free Evaluation version to analyze the software

1.3.1.2 Graphical User Interface

Now that Kernel for Novell GroupWise to Exchange has been installed on your computer, you can start
using the software after getting acquainted with the software interface.

Menu Bar

The menu-bar of Kernel for Novell GroupWise to Exchange comprises three main menus— File, Tool and
Help.

File Menu

The File menu comprises four menu items.

File | Tool  Help

| Single Mailbo:
[l Batch File

Ld Export

Exit

Figure 1.1: File Menu of Main Application

Menu items in the File menu:

Single Mailbox Select to convert Single GroupWise User mailbox

Batch File Select to convert Multiple GroupWise user mailboxes saved in a
NUCON batch file

Export Select to export/save items of the mailbox

Exit Select to close the software

©Nucleus Data Recovery.Com Private Limited GroupWise & Exchange



Tool Menu

The Tool menu comprises one menu item.

Tool | Help

Advance Opkions

Figure 1.2: Tool Menu of Main Application

Menu items in the Tool menu:

Advance Select to view advanced options to customize various activities
Options

Help Menu

The Help menu comprises three menu items.

Help
2 Help

Software home page. ..

about Kernel for Movell Groupiise to Exchange

Figure 1.3: Help Menu of Main Application

Menu items in the Help menu:

Help Select to view Users Help Manual of Kernel for Novell GroupWise
to Exchange

Software home Select to visit homepage of the software on our website

page...

About Kernel Select to know version information and support details of Kernel
for Novell for Novell GroupWise to Exchange

GroupWise to

Exchange

Kernel 0
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Tool Bar

The tool-bar in Kernel for Novell GroupWise to Exchange is displayed below the menu-bar. The tool-bar
provides a convenient and user-friendly method to perform certain actions that can also be performed by
using the menu-bar. Read the information in the table below to find out about the tool-bar buttons:

Single Mailbox Select to convert Single GroupWise User
D mailbox
Single Mailbox
Batch File Select to convert Multiple GroupWise user
ED mailboxes saved in a batch file
Batch File
Export Select to export/save items of the mailbox
ks
Export
Help Select to view Users Help manual of Kernel for
Jff; Novell GroupWise to Exchange software
Help
Buy Online Select to purchase Kernel for Novell GroupWise
= to Exchange software
Buy Online
Status Bar

Status bar is displayed at the bottom of the software window. The text ‘www.nucleustechnologies.com’ is
displayed on the status bar when you open the software. This text changes according to the actions
performed with the tool bar buttons. For example- Status bar displays the text ‘Single File’ when you put
mouse on Single File button to perform single file conversion and then changes back to
‘www.nucleustechnologies.com’.

The Status bar also displays the text ‘CAP’, ‘NUM’, ‘SCRL’ which respectively correspond to the Caps
Lock, Num Lock, and Scroll Lock keys on your keyboard. If any of these keys are pressed, the color of the
corresponding text will turn blue/black.

Iwww.nucleustechnnlugies.cnm PR

Figure 1.4: Status Bar of Main Application
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Buttons Used

Apart from the standard options available in the menu-bar and the tool-bar, following are the main buttons
used throughout the software working.

Click to go to the next screen
Mext
Back Click to go back to the previous screen
Exit Click to exit from the software
Click to save/export items of the user mailbox
Export
Stop Click to stop the saving/scanning process

Customize User Interface

You can add or remove toolbar buttons by clicking:

- Add or Remove Buttons - Standard in the toolbar and selecting appropriate buttons.

1.3.2 Kernel for Novell GroupWise to Exchange Migration File Creator

Kernel for Novell GroupWise to Exchange Migration File Creator creates a .NUCON batch file that lists
and records details of unlimited GroupWise user mailboxes for conversion to PST or MS Exchange
Server. Batch file eliminates the pain of converting GroupWise User Mailboxes one by one. Creation of
batch file saves the valuable time of administrators/technicians.

Kernel for Novell GroupWise to Exchange Migration File Creator has the feature of importing MS Excel
worksheet that is used to store complete information about the Novell GroupWise user mailboxes.

1.3.2.1 Graphical User Interface

As the batch file creation tool - Kernel for Novell GroupWise to Exchange Migration File Creator has been
installed automatically on your computer system with the installation of Kernel for Novell GroupWise to
Exchange software; you can start creating batch file to perform multiple mailboxes migration after getting
acquainted with the software interface of batch file creator tool.

Menu Bar
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The menu-bar of Kernel for Novell GroupWise to Exchange Migration File Creator comprises four main
menus — File, Edit, View, and Help.

File Menu

The File menu comprises six menu items.

Ele | Edit  iew b
"1 Mew File

E§ Add Record

[:'f Qpen...

hd Save

Eé Save As...

Exit

Figure 1.5: File Menu of File Creator

Menu items in the File menu:

New File Select to remove all existing records listed in the Kernel for Novell
GroupWise to Exchange Migration File Creator software and
create new record for a new batch file

Add Record Select to add new record of the user mailbox in a batch file

Open Select to open an existing .NUCON batch file

Save Select to save the .NUCON batch file

Save As Select to select the location on your hard drive to save the

.NUCON batch file

Exit Select to exit from the software

Edit Menu

The Edit menu comprise of single menu item:

Kernel W
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Edit | Yiew Help

g‘ Remowve

Figure 1.6: Edit Menu of File Creator

Menu items in the Edit menu:

Remove Select to remove the selected record from the list

View Menu

The View menu comprises two menu items.

[ P=10] ] Help
Toolbars

2 Standard

Cuskomize, ..

HE SOV g

Figure 1.7: View Menu of File Creator

Menu items in the View menu:

Toolbars Select to view or hide toolbar of Kernel for
Novell GroupWise to Exchange Migration File
Creator software

Status Bar Select to view or hide status Bar of Kernel for
Novell GroupWise to Exchange Migration File
Creator software

Help Menu

The Help menu comprises three menu items.

Help |

Help

Software HomePage

= About Kernel for Movell Grouphise to Exchange Migration File C...

Figure 1.8: Help Menu of File Creator
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Menu items in the Help menu:

Help Select to view help information pertaining to performing
various tasks using Kernel for Novell GroupWise to
Exchange Migration File Creator

Software Homepage Select to visit homepage of our website
About Kernel for Novell Select to view version-related and support information of
GroupWise to Exchange Kernel for Novell GroupWise to Exchange Migration File
Migration File Creator Creator

Tool Bar

Following are the tool bar buttons used in the Kernel for Novell GroupWise to Exchange Migration File
Creator:

New Select to remove all existing records listed in the
D Kernel for Novell GroupWise to Exchange
New Migration File Creator software and create new

record for a new Kernel batch file

Open Select to open the existing .NUCON file
o

Open

I ! Save Select to save the .NUCON batch file

Save

Save As Select to define the location on your hard drive to

Eé save the .NUCON batch file
Save As
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Add Record Select to add the records/details of the
EJ:' GroupWise user mailbox and saving options
add Record
Remove Select to remove the selected record from the list
o0
Remove
Help Select to view User's Help Manual of Kernel for
Novell GroupWise to Exchange Migration File
Help Creator software
; Import Excel Select to import excel worksheet with added
& information about the batch of GroupWise
Impark Excel mailbox(s) to be migrated
Status Bar

Status bar is displayed at the bottom of the software window. The text ‘Ready’ is displayed on the status
bar if Kernel for Novell GroupWise to Exchange Migration File Creator is ready to be used. Status bar also
displays the text ‘CAP’, ‘NUM’, ‘SCRL’ which respectively correspond to the Caps Lock, Num Lock, and
Scroll Lock keys on your keyboard. If any of these keys are pressed, the color of the corresponding text
will turn blue/black.

Ready TLIR

Figure 1.9: Status Bar of File Creator
Customize User Interface

You can add or remove toolbar buttons by clicking:

- Add or Remove Buttons - Standard in the toolbar and selecting appropriate buttons.
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2. Getting Started

Now that you have understood the features and potential of Kernel for Novell GroupWise to Exchange,
you are ready to get hands on experience of the software. To start migrating files, you will first need to
download and install this software. However it is strongly recommended that before installing Kernel for
Novell GroupWise to Exchange, you should go through the installation pre-requisites for the software to
ensure that your computer is appropriately configured to run the software.

2.1 Installation Pre-requisites and System Requirements

The various pre-requisites for installing and running Kernel for Novell GroupWise to Exchange can be
broadly classified into two major categories — Hardware requirements and Software requirements.

2.1.1 Hardware Requirements:

The hardware requirements for installing the software are as follows:
e Pentium Class Processor
e Minimum 64MB RAM (128 MB recommended)
e 10MB for Software installation

o Disk Space - Enough space to save the results

. You should have at-least 10 MB of free disk space if you want to export and save 10
MB .PST file.

2.1.2 Software Requirements:
The software requirements for installing the software are as follows:
2.1.2.1 Operating System Requirements
Supported operating systems:
e Windows Vista
e Windows XP
e Windows 2003

e Windows 2000

2.1.2.2 Novell GroupWise Server Requirements

Supported Novell GroupWise Server versions:
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e Version 6, 6.5, 7
2.1.2.3 MS Outlook Requirements
Supported MS Outlook versions:
¢ MS Outlook 97 and above (97, 98, 2000, 2003, 2007)
2.1.2.4 MS Exchange Server Requirements
Supported MS Exchange Server versions:
e All versions of MS Exchange Server
2.1.2.5 MS Excel Requirements
Supported MS Excel versions:

e MS Excel 97, 98, 2000, 2002, 2003 and 2007

2.2 Downloading Kernel for Novell GroupWise to Exchange software
for the First Time

After checking your computer with the prescribed system requirements for Kernel for Novell GroupWise to
Exchange, you can download and install the software on your computer. You can buy the full version of
the software from any one of our authorized resellers— Element5, Asknet and 2CO.

If you want to try using Kernel for Novell GroupWise to Exchange before buying it, you can download the
evaluation version from the following link:

http://www.nucleustechnologies.com/download-groupwise-to-exchange.php

X You can export unlimited GroupWise files saved on your system by using the
evaluation version of Kernel for Novell GroupWise to Exchange; however, the
evaluation version lets you save 10 emails per folder of the converted GroupWise
mailbox.

2.3 Installing Kernel for Novell GroupWise to Exchange

After downloading the installer file for Kernel for Novell GroupWise to Exchange, you can install the
software by running the file.

To install Kernel for Novell GroupWise to Exchange:
1. Double-click the Kernel for Novell GroupWise to Exchange installer. Follow the on-screen instructions.
The Setup Installation Complete screen will be displayed.

2. Click Finish to launch the software.
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http://www.nucleustechnologies.com/download-groupwise-to-exchange.php

™ When you run the Kernel software setup, two programs gets installed in the All
Programs menu and two desktop icons are created: Kernel for Novell GroupWise to
Exchange.exe and Kernel for Novell GroupWise to Exchange - Batch Migration File
Creator.exe

2.4 Un-installing Kernel for Novell GroupWise to Exchange

You may need to uninstall and re-install Kernel for Novell GroupWise to Exchange. To uninstall Kernel for
Novell GroupWise to Exchange:

1. Click the Start = All Programs >Kernel for Novell GroupWise to Exchange - Uninstall Kernel
for Novell GroupWise to Exchange

A warning message will be displayed.

2. Click ‘Yes’ to uninstall Kernel for Novell GroupWise to Exchange.

. Before proceeding to uninstall Kernel for Novell GroupWise to Exchange, you must
ensure that the software is not running.

You can alternatively uninstall Kernel for Novell GroupWise to Exchange from the Control Panel by
performing the following steps:

1. Click the Start Menu - Control Panel and then double click the Add or Remove Programs icon.
2. Select Kernel for Novell GroupWise to Exchange and click Remove.
A warning message will be displayed.

3. Click ‘Yes’ to uninstall Kernel for Novell GroupWise to Exchange.
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3. Migration from Novell GroupWise to Exchange
Server

Now that you have complete familiarity of the user interface of Kernel for Novell GroupWise to Exchange,
you are ready to perform the migration of GroupWise mailbox(s).

3.1 Single Mailbox Migration

1. Launch Kernel for Novell GroupWise to Exchange software.

|K| Kernel for Movell GroupWise to Exchange - Ver 9.05.01
| Fle Tod Hep

2 B O [ NUCLEUS |

| SigleMsibox BatchFls Export  Help DATA RECOVERY

ﬂ Step 1:

Please select the
Conversion Option

Please select appropriate option
Step 2:

-
! ) ] (Z)Select this option bo converk single GroupiWise Maibox
A

N
. I a/ / () Select this option to convert bateh of GroupWise Mallboxes

& g \ Migrate Single Groupiise User Mailbox or 3 Batch file consisting of Groupwise User Mailboed(s) with Kernel for Novell GroupWise to Exchange software.

1. Convert Single GroupWise Mailbox option helps ko corvert one mailbox at a time,
2 . Convert Batch of Groupiise Malboxes helps to convert unimited GroupWise user mailboxes at a time. Refer software help to get more knowledge abouk Batch file creation.

Seleck appropriate option and click Next bukton

Kernel
7 oy I ~—
wee. nucleustechnologies, com NUM

Figure 3.1: Main window of Kernel for GroupWise to Exchange

2. Select the radio button ‘Select this option to convert single GroupWise Mailbox’ and click Next
button.

On clicking ‘Next’, window displays three modes to connect to the mailboxes of Novell GroupWise and
archive selection option: Default Mode, Login Mode and Command Line mode.
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© File Tool Help

e B @ & | NUCLEUS

| Single Mailbox BatchFile Export  Help  Buy Online - DATA RECOVERY

v/’ Stepl: Default Mode
Please select the (&) Use Default
Conversion Option
Login Mode
D stepz User Id : | |
Flease select the Mode to
conneck b Groupihise Passward: | |
Mailboxes
O arline Address: | | Port: | |
Step 3:
Preview emails and other © Caching mailbex path | |
itemns of converted ;
Remat; [ th
Group'Wise User mailbox: © Remote maibiox pa | |
Step 4: Command Line Mode
Select and Save folder(s) (O Command Line (for advance migration)
in .PST or Exchange
Server |

Migrate Archive items {In case if you want to migrate Archive items)

[ show archive

Select the appropriate mode to perform the Groupiise to Exchange migration with Kernel for Movell Groupitise to Exchange software.

" \ Default Mode: This mode helps to convert the default opened user mailbox in Movell GroupiWise server.
KE R. N E l| Login Mode: This mode provides sub-modes where mailbaxes can be converted with Online details, Caching Mailbox Path and Remote Mailbox
18" =S
Back Next
v, nucleustechnologies, com UM

Figure 3.2: Window showing three modes
3. Choose any of the modes as per the requirement and perform migration of Single GroupWise mailbox.
o Default mode: This mode converts the items of currently opened mailbox in GroupWise Client.

e Login Mode: This mode provides sub-modes, where mailboxes can be connected and converted
with Online details, Caching Mailbox Path and Remote Mailbox path of the mailbox file.

e Command Line Mode: This mode helps to access and convert GroupWise mailbox without
accessing or opening the GroupWise Client. ltems of the mailbox are easy to convert by typing
complete mailbox path: /pr-/"mailbox destination location"

3.1.1 Default Mode

Default mode migrates the currently opened user mailbox in Novell GroupWise client.

1. Select the "Use Default" option to connect to the GroupWise mailbox in Default mode.

Kernel Q;‘,
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| e Tool Hep

© &

U I

() Command Line {for advance migration)

) 7
© Single Mailbox  BatchFle  Export  Help DATA RECOVERY
v Step 1: Default Mode
Plaasa selact the (& Use Default
Conversion Option
Login Mode
Flaase selact the Mode to
Gt e Gt
Maikores
O Cinine Address: | | Port: | |
Step 3
p OCach'mg mailbox: path | |
() Remote maibox path | ]
Step 4: Command Line Mode

|,-| r-lEAgrpluser?

Migrate Archive items {In case if you want to migrate Archive items)
[¥] show Archive
(5 Use defauk Archive path
) Specify Archive path [ ]

Select the appropriate mode to perform the GroupWise to Exchange rigration with Kernel For Movell GroupWise to Exchange software.

-
@ Defauk Mode: This mode helps to convert the default opened user mailbox in Novel Group'Wise server,

Login Maode: This mode provides sub-modes where maiboxes can be converted with Online detais, Caching Mailbox Path and Remote Maibox path of the mailbos file,

P Commandine mode: This mode helps to socess and convert GroupWise malbox without accessing the GrouplWise Clisnt, exe. Ttems of the mailkox are easy to convert by providing the software
KE RN,E | with complete mailbox path
‘ . Back J ’ . Next
e, rucleustechnelogies. com —

Figure 3.3: Using Default Mode

3. This option is enabled by default in the software.

2. Activate and select the Archive file options to migrate archived emails. Click Next button to continue.

Software shows all the existing folders in a tree like structure.

3. Select any of the tabs to view the preview of selected email either in Text or HTML format.

Kernel @
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e @ E @ NUCLEDS)

Snjemlm: BatchFle Expot  Help  « DATA RECOVERY

W Step 1 e Click any folder to view converted emails
Please selact the 3
Conwersion Optio = ice Mailboo:
s " @] Z "““""‘;ﬁ] From Subjact Date | ant ~
P T a1 [ Marjunath Kavitha Ganapaneni: Path 4/3/2006 10:07:00 A4 [] OTP_Tmesheet Kavk
v Step [P JunkMsl L5 Anju<anu.sharma@p Re: Thought For The Day 4/5/2006 12:13:23 PM
Emf::mw:‘m [ calendar(22) (15 Anju<anju.sharma@p Fw: Tos Cream!! 4/26[2005 11:53:13 AM | [] IMAGE.of
Maiboxes [] 3 Nokes{3) [ Manjunath RE: Time shest S[3/2006 1:44:47 PM
O steps: —; ;:Itb:::ms(aj [ Manjunath Timesheet April 0 = 542006 30542 PM [ OTP_Timeshest_Kawt &
Previews emails and other 3 |
“@m,;?&:?fm [F18 Contacts . REKavitha Ganapaneni: [T imesheet for Feb 06
—'J, Documenits _J “anjunath Lakshrinarayanan - T
Step 4 21 Checklist{26) 32212006 5:11:34 PM
Save Feldh [#15 work In Progress{
# [#)3 Cabinet | S HEm Y Text
& Trash A

% [#)8a Al hddressBook Conkacts Anjuri,
| just forwarded it in my previous mail to you.

Thanks
Manjunath

-----Original Message-----
From: Anjuri [mailto:

< > O e Moo mndee. Rl M AAAL C.NAT NRA

Kernel

Figure 3.4: Preview Window
Emails, calendar, contacts and other items will be displayed in the left pane of the window. Right pane of
the window displays the respective items of the folder selected from the left pane. Bottom pane displays
the preview of the item selected from the right pane of the window.
4. Click Export button to continue.

Software asks for the Save Options whether to Save in PST or Save in Exchange Server.

Save Options E'

Flease zelect zave option

{(®) Save in PST

(") Save in Exchange Server

| oK |[ Cancel

Figure 3.5: Save Options

5. Select the appropriate radio button and click OK button.

Kernel QJ
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3.1.1.1 Saving with PST

To save the GroupWise mailbox items in PST:

1. Select the "Save in PST" radio button and click OK.

Save Options

{(*) Save in PST

Fleaze select save option

(") Save in Exchange Server

X]

Ok

|[ Cancel ]

Figure 3.6: Saving with PST

2. Define PST Folder Path and PST File Name and click OK.

File location

PST Folder Fath

PST File Mame :

|E:'|I

|L|ser1|

OF.

)

[ Cancel

Figure 3.7: Window asking for PST File location

Software starts saving selected folders at the selected location.
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B oo Hep

e B K @

| Srgje Mabox BatchFilke Export  Help

YU [J
DATA RECOVERY

v Step l:
Flease select the
Canwerson Cption

v Step2:
Please select the Mode to

Hide Progress ~ <-You can speed up the saving process by hiding the progress - Yiew software help for more details.

Migration process details

Curvent Frogress - {Saving Folder 6 of 31) - (Saving Emall 60 ) - Current Folder Name : - $$§1Maiboxd

Sarving Folder:§4§iMaibo:,

connact to GroupWiss Sarving Emall 50
Mallzoas Log P : C:\Progran Piissikernel For Nowel GroupWiss to Exchangs Migration LoglMonday 04 May 2009 16 38 30.txt
v Step X
1 “ ~
. nd S Sérve SkBUS | SUCess.
Rems of converted S SEAlUS : SUCCESS. .
Grouphie Liser mailbax Saving Emal 54 ° o
D Stepa: - Save Statug © SUKess. .
Salect and Save Folder(s) Save Status : Success..
in P57 or Exchange Saving Emal 56
Sorver Sarvn Status : Sucoess. .
Saving Emal 57
Save Status : Success. .
Saving Emal 58
Save Shabus : Success. ..
Saving Emal 59
Sarve Skabus : Success. ..
Saving Emal 60
Sanve SEatus © SUCCess. . -
E Saving Folder | FRFINSIDG:, Tota Progress : 19% ]
&= -
Kernel
vr] Stop
v nudeustechnologies.com UM

Figure 3.8: Saving Process

Emails and other items of the user mailbox are saved in new PST file with original folder structure of the
Novell GroupWise mailbox.

3.1.1.2 Saving with Exchange Server

To save the GroupWise mailbox items in Exchange Server:

1. Select the "Save in Exchange server" radio button and click OK.

2. Provide the details for Microsoft Exchange Server, User Name, Password, and Domain Name and

then click OK.
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Exchange Server information

Tupe the name of Exchange Server caompiter

Microzoft Exchange Server: * 210109078

Type the name of mailbox set up by vour administratar. The mailbox name is ugually your uger name.

[ .
Lzer Mame: | testing

Type the paszword of mailbox set up by vour administrator.

FPasgword: * | sectese |

Type the Domain M ame fram which mailbox belongs

Diomair Mame: * | service |

[ OF. ] [ Canicel ]

Figure 3.9: Exchange Server Information

Software starts saving the mailbox items in MS Exchange Server user profile.
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i Ble Tocl Help
) VU [
e B E @ | NUCLEUS 4
e o G BT e DATA RECOVERY
V’ Step 1 Hide Progress <=¥ou can speed up the saving process by hiding the progress - Yiew software help for more details.
ep iz
Flease select the
Canwerson Cption Migration process details
v StepZ: Curvent Frograss - (Saving Folder & of 31) - (Saving Emall 60 ) - Current Folder Name : - $$§Maibox]
Flease select the Mode ba Saving Folder:#§§iMaibox)
connadt bo Groupiwess Sarving Emall 50
Mallzoas Log P : C:\Progran Piissikernel For Nowel GroupWiss to Exchangs Migration LoglMonday 04 May 2009 16 38 30.txt
v Step X
S Skt : Switess. . ~
Preview emails snd other Saving Emal 53
Rems of converted S SEAlUS : SUCCESS. .
Groupiwise Uiser mailbon: Saving Emal 54 ° o
- Save Statug © SUKess. .
O steps: Saving Emal 55
Salect and Save Folder(s) Save Status : Success..
in PST o Exchange Saving Emal 56
Sorver Sarvn Status : Sucoess. .
Saving Emal 57
Save Status : Success. .
Saving Emal 58
Save Shabus : Success. ..
Saving Emal 59
Sarve Skabus : Success. ..
Saving Emal 60
Sanve SEatus © SUCCess. . -
|
E Saving Folder | FRFINSIDG:, Tota Progress : 19% ]
Kernel
v+ Stop

Figure 3.10: Saving in progress
Emails and other items of the user mailbox are now saved.

3.1.2 Login Mode

Login mode provides three sub modes: Online, Caching and Remote.
Online Mode
1. Select the Online radio button to access the GroupWise mailbox in online mode.

2. Type the User Id and Password of the mailbox which you want to migrate from Novell GroupWise to
Exchange.

3. Type the IP address and Port number of the computer where Novell GroupWise Server is installed.
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: ple Tool Help

EWENC

: Single Maibox  Batch File  Export

YU 1L
DATA RECOVERY

v Stepl:
Please select the
Corversion Option

@ Step2:

Pleags select the Mode to

connect to Groupiise
Mailboxes

Kernel

e nucleustechnologies. com

Default Mode

() Use Default
Login Mode
User Id
C— [ 1]
® oriine address: [192.168.16.18 | Port: [a56 |
O Cadhingmaiborcpath [0 |

ORemate maibox path | |

Command Line Mode

() Command Line (For advance migration)

|.'|u-.-'l Agrpluser?

Migrate Archive items (In case il you want ko migrate Archive items)

[ shows archive

Selact the appropriabe mode bo perform the Groupbise bo Exchange migration with Kernel For Nowvell GroupWise to Exchange software.

@ Default Made: This mode helps to convert the default opened user maibox in Novell GroupWise server.

Login Mode: This mode provides sub-modes where maiboxes can be converted with Online details, Caching Malbox Path and Remate Malbox path of the malbox file.
Commandline mode: This made helps to access and convert GroupWise mailbox without accessing the GroupWwise Client.exe. Ttems of the maibox are easy to comvert by providing the softveare

with complete malbox path

Back I [ Next

Figure 3.11: Using Online Mode

4. Click Next button to proceed.

Select any of the GroupWise mailbox items to view its contents.

5. Click Export button to save the mails.

Software asks for the Save Options whether to Save in PST or Save in Exchange Server.

6. Select the appropriate radio button and click OK button.

The saving process is same as described in Section 3.1.1.1 and 3.1.1.2.

Caching Mode

1. Select the Caching mailbox path radio button to access the GroupWise mailbox in cache mode.

2. Type the User Id and Password of the mailbox which you want to migrate from Novell GroupWise to

Exchange. Also define the caching mailbox path with the ... button.
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| Ble Tod Help

s B EH @
Help -

 Single Malbox Batch Fde  Export

Ty 1L
DATA RECOVERY

v Step l: Default Mode
Please select the (O Use Defailt
Corversion Oplion
Login Mode

Please select the Mode to
connect to Group'Wise Passwerd: Cl
Mailboes

© online Aderess: 192 166.16.18 | Pest: [ass |
step®

@fatigmaibaxpah  [Diluserz JC-J
O Remote malboxpath [0 ]

Command Line Mode

(2 Command Line (For advance migeation)

|,u'| rElgrpluser?

Migrate Archive ibems (In cage if you want bo migrate Archive items)

[ show archive

Select the sppropriabe mode bo perform the GroupiWise bo Exchange migration with Kernel For Novell Groupwise to Exchange software.
y
Dafault Mode: This made helps ko convert the default opened user maibox in Novel Group'Wise server.

KE RN’ _E l! with complete mailbox path

i, nucleustechnologies. com

Login Mode: This mode provides sub-modes where maiboxes can be converted with Online details, Caching Maibox Path and Remote Maibox path of the maibo file,
Commandline mode: This mode helps to access and convert Grouphdiss mallbox without aocessing the GroupWise Cliank,exe, Ttems of the mailbos are sasy to conwert by providing the software

! Back ] I Mext

Figure 3.12: Using Caching Mode
3. Click Next button to proceed.
4. Further steps are same as step 5 and 6 of above mentioned Online Mode.

Remote Mode

1. Select the "Remote mailbox path" radio button to access the GroupWise mailbox in remote mode.

2. Type the password of the mailbox which you want to migrate and define the remote mailbox path

through the ... button.

Kernel QI
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Step 4:

Kernel

| Ble Tod Help
[ : | NUCLEUS J
o B kW @
¢ Single Maibox Batch File Export  Help DATA RECOVERY
W' Step 1: Default Mode
Please select the O Use Default
Conwversion Option
Login Made
@ a2 st C—
Pleass salect the Mode to
e o — Co—
pabores O Grline Radress: [192.168.16.18 | Pert: [ass |
Step 3: |

O Caching malboo: path |

[Ditvibas?

Command Line Mode

() Command Line (For advance migration)

Migrate Archive items (In case if you want to migrate Archive items)

[] shows Archive

Saleck the approprizbe mode to perform bhe GroupWise to Exchange migration with Kernel For Newvel GroupWise to Exchange softweare.

@ Default Mode: This mode helps bo convert the defaul cpened user maibox in Novell Groupiwise server.
Login Mods: This mode provides sub-modes where maibosees can be corverted with Onling details, Caching Mailbox Path and Remobe Malbax path of the malbos: file,
Commandine mode; Ths mode hels b ccess and convert GroupWise maibos without actessing the GroupiWise Client. exe, Ttems of the maibax are easy ko corert by providng the softwere

with complete maibo:x path

Back l [ MNext

Figure 3.13: Using Remote Mode

W@ Password is required for only those mailboxes which are password protected,
otherwise there is no need to provide password for authentication.

3. Rest steps are same as step 5 and 6 of above mentioned Online Mode.

3.1.3 Command Line Mode

Command Line mode helps you to access the GroupWise mailbox without opening or accessing the
Novell GroupWise.exe and user mailbox account. If you know the path where GroupWise mailbox is
saved, then type the path in Command Line mode and access that user mailbox for migration.

1. Select Command Line (for advance migration) radio button to perform the migration with Command

Line Mode.

2. Type the User ID, Password and the User GroupWise Mailbox path.

Kernel
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Step 1: Default Mode
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Conversion Option
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ot apuis - Co—
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Step 3:
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) Remote madbox path I |

Step 4: Command Line Mode

(&) Command Line (for advance migration)

Ipr-{Ex\grp\user2 |

Migrate Archive items {In case if you want to migrate Archive items)

] shiow Archive

[ ]

Seleck the sppropriste mode to perfontn the Group'Wise to Exchandgs migration with Kemel For Novel Groupiise ta Exchange softwars.

| Defauk Made: Thiz mode Pl tes conwert the default opened user malbox in Novell Group\Wise server.
Lagin Mode: This mide provides sub-modes where malbaxes can be converted with Online detals, Caching Maibox Path and Remate Mailbo:: path of the mailbo:x file,

W Ceenmandine made: This mede helps bo sccess and convert Group wailba without the Group Client.exe, Tterms of the malboo: are easy to convert by previdng the software
KERNE | with comglete malbox path

sk | (B tem

v rcleustechnologies. com L

Figure 3.14: Using Command Line Mode

X Remote Novell GroupWise mailbox can be accessed with the switch and the
complete path of the mailbox which is required to be migrated.

3. Click Export button from the toolbar or simply click Next button to continue.

4. Rest steps are same as steps 5 and 6 of above mentioned Online Mode.

3.2 Multiple Mailbox Migration

Multiple Mailbox Migration lets you migrate unlimited GroupWise files at once. Batch file is one medium
with which you can easily list and convert unlimited GroupWise user mailboxes at once. Batch file stores
records of unlimited GroupWise user mailbox accounts. Creation of batch file eases the task of defining
saving location and saving mode for the converted mailboxes in PST or Exchange Server.

3.2.1 Creating .NUCON Batch file

1. Launch Kernel for Novell GroupWise to Exchange Migration File Creator software.

Kernel q‘,
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. Ele  Edit  wiew Help

D EE % 6@ 3 LLLCL”

Tt CpEn Save  Save As | Add Record Remove Help  Import Excel - DATA RECOVERY

Record Details Profile Folders/File Path

-2

Maode | User Id | Password | Address | Part | C

=
Mode
User Id
Passwiord
Address
Part
Carching Mailbox Path
Remate Mailbox Path
Command Line
=
User Marme

| £

b

Kernel

Ready TR

Figure 3.15: Main window of File Creator software
2. Select ‘Add Record’ option from the File menu or click the ‘Add Record’ button from the tool bar.

3. Provide the various related information, as in, user id, password, online, caching mailbox details, etc.

Kernel @
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GroupWise Information

Pleaze add all Grouphfize related information

Grouphize Login Details Advance Options
User Id || Thiz option iz uzed in case it zaftware iz not able to
access FAemate Maibox Path or Caching Mailbox Path
Paszword | Note -
The uzer name should be followed by domain name
E le: domain®
& Orline Address | Pait xample: domainhusernanme
™ Caching Mailbax Path |
|Jzer Mame |
™ Remate Mailbox Path |

FPazzwmard |

" Caommand Line [for advance migration] ‘

Computer Mame/p: |
Archive Detailz

[ Migrate Archive items
{+

E o

| Meut = | Cancel

Figure 3.16: GroupWise Information

@ Select any of the modes (Online, Caching, Remote, and Command Line) to get
access to the GroupWise user mailbox.

4. After filling up all the relevant information, click Next button.

As you click Next, Kernel for Novell GroupWise to Exchange Migration File Creator software provides
saving options: Save in PST and Save in Exchange Server to choose from it.

Kernel Q;y
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Outlook f Exchange Information

PST File Path | J

PST File Name |

" Sawve in Exchange Server

Exchange Server Mame" |

Exchange Mailboy® |

Pazzwaord”® |

Damain® |

¢ Back | Finizh | Cancel

Figure 3.17: Outlook/Exchange Information

5. Select any of the saving option and provide the details accordingly.

Kernel q‘,
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Outlook f Exchange Information

" SaveinPST

PST File Path |

PST File Name |
* Save in Exchange Server
Exchange Server Mame"
Exchange Mailboy®

Pazzwaord”®

Damain®

|Sewer 1

|LlserT

|FGDSJ?EBDSHFW

|5EFW|:E

¢ Back | Finizh |

Cancel

Figure 3.18: Information for Exchange Server

6. Click Finish button to continue.

All the created records of the GroupWise User Mailboxes get listed in the software.
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Record Details Profile Fobders,File Path

roperlies | [ Mode [User 1d | Password | Address | Port | Caching Madbor: ... | Remote Mabos... | CommandLine | User Name [ Uiser Pad]
Bl GroupWise Propertics Remote Madbo ... <Emwpd.. <Empty> <Emp.. <Em.. <Emply> DiiSoftlremote  <Emply> <Emply> <Enmgly
Mods Refcte Malbeo: ... <Empd...  <Empty>  <Emp.. <Em.. <Emply> Dk <Efrply> <Errply> <Enrply:
R Remots Malbco: ... <EmpR... <Empty> <Emp.. <Em.. <Empty> Driwvkasd <Effgty> <Ermpty> <Emply’
Pa a Remote Malbox ... <Empt... <Emplty> <Emp... <Em.. <Emply> D:iwikasd <Emply> <Ermply <Emgly:
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Fart

Caching Madbox Path

Ressreote Maibse Path

Coeremand Line
E A yWise Remol e loo) 3

k2 :
Kernel
£ *

Foady

Figure 3.19: Created Records

7. Click the Save button from the tool bar to save the batch file or click the Save As button to select and

define saving location for the batch file on your computer system.

Save As @
Save in; | (&} Desktop j £ Eg-
E}My Dacurents
d My Computer
HM':.-' Metwork Places
File name: | NucleusMiarationFile]
Save az type: |TEHt File [*.nucon) j Cancel

Figure 3.20: Saving .NUCON file

. Kernel for Novell GroupWise to Exchange Migration File Creator software by default
creates *.NUCON file extension for the created batch file for multiple mailbox
conversion.
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3.2.2 Creating Excel Database

Excel datasheet is another way of performing multiple mailbox migration. Information regarding various
Novell GroupWise user mailboxes is easily saved to an excel worksheet according to the provided file
format. Save details in .XLS file and export it to Kernel for Novell GroupWise to Exchange Migration File
Creator software to get it saved to .NUCON batch file.

Excel sheet (.XLS) to be imported should be in the following format.

[’Dn\ - s purchase-department.xls [Compatibility Mode] - Microsoft Excel e
- Home Insert Page Layout Farmulas Data Review View Developer W - = X
* Calibri Sl (AN AT = || | S Wrap Text General - !‘_{ﬁ E"‘; i:‘_ﬂr jm j‘ E_I _}: - é? L?&
Paste o [ T ol | | R e R A | EEEIE i S Merge & Center = | | $ v % v || %0 g Conditional Format  Cell Insert Delete Format E 7 Sort & Find &
g il J =) B *3] | Formatting = as Table = Styles - - . 27 Filter= Select~
Clipboard = Font fu Alignment fu Mumber E] Styles Cells Editing
i A17 ~ (s | %]
| A | 8 c D E |F G Hidiadiilesial K L M N o lr
1 Mode User ID Password Address Port  Cact Remote Mailbox Path  Comn User User P: Compu PST File Path PST File Name Exchange £ Exchar Exch:
2
3 Remote Mailbox Path gol.{OL> D:\user D:\pst-files user
4 Remote Mailbox Path sdgrfwer D\userl D:\pst-files userl
5 Remote Mailbox Path 67383jd D:\user2 D:\pst-files userl
6 |Remote Mailbox Path ewfr D:\user3 D:\pst-files userd
7 Remote Mailbox Path Gyhn~YHN D:\userd D:\pst-files userd L
& Remote Mailbox Path 235tgv D:yusers D:\pst-files users
9 Remote Mailbox Path 34hdaw D\users D:\pst-files users
10 Remote Mailbox Path 25gsf D:\user? D:\pst-files user?
11 Remote Mailbox Path 1gazlQAZ D:\users D:\pst-files userd
12 Remote Mailbox Path 2wsK@WSN D:\userd D:\pst-files userd
13 Remote Mailbox Path AYHMNGyhN D\userld D:\pst-files userld
14
15
16
17 !
W4 » M NuckeusExcelShest - Sheet2 - Sheet3 -~ 7J e | m
Ready | ]

Figure 3.24: Excel sheet format
1. Tab name of the sheet should be NucleusExcelSheet.

2. Sheet should consist of 19 columns.

Field 1 Mode

Field 2 User ID

Field 3 Password

Field 4 Address

Field 5 Port

Field 6 Caching Mailbox Path

Kernel @
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Field 7 Remote Mailbox Path
Field 8 Command Line

Field 9 User Name

Field 10 User Password

Field 11 Computer Name/IP
Field 12 PST File Path

Field 13 PST File Name

Field 14 Exchange Server Name
Field 15 Exchange Mailbox
Field 16 Exchange Server Password
Field 17 Domain

Field 18 Save Archive

Field 19 Archive Path

3. Fil

| up the fields according to the login type selected amongst

e Online

Following are the mandatory fields to be filled in while using this mode:

User ID: Type the user name of the mailbox.
Password: Type the password of user mailbox.
Address: Type the IP address of the Novell GroupWise Server

Port: Type the Port Number of the Novell GroupWise Server.

V.  Archive Details: Always type "NO" in this field if you want to migrate the mailbox items only.

VI.

Save in PST: There are two fields in this option:
e PST File Path

e PST File Name

Kernel (;j
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If you want to save the migrated items in PST file then type the PST path location in both the fields,
otherwise it will be an error.

VIl.  Save in Exchange Server: There are four fields in this option:
o Exchange Server Name
o Exchange Mailbox
o Password
o Domain

If you want to save the migrated items to the user mailbox on MS Exchange Server, then all the four
fields are compulsory, otherwise it would be an error.

@ NOTE: Only one amongst “Save in PST” and “Save in Exchange Server” should be
filled, otherwise software will display an error.

e Caching Mailbox Path
Following are the mandatory fields to be filled in while using this mode:
I.  User ID: Type the user name of the mailbox.
.  Password: Type the password of user mailbox (if any).

lll.  Caching Mailbox Path: Browse and list the path for Caching Mailbox of Novell GroupWise account
to be migrated.

IV.  Archive Details: Always type "NO" in this field if you want to migrate the mailbox items only.
V.  Advance Options: Provide details to these fields if you are accessing the Caching mailbox from a

network computer. This section will comprise of the login details of the computer in network. There
are three fields in advanced options:

VI.  User Name of the network computer where mailbox is saved
VII.  Password of the network computer where mailbox is saved
VIIl.  Computer Name/IP of the network computer where mailbox is saved

IX.  Advanced options fields are not compulsory, but recommended. If not filled, it will be shown as a
warning.

X.  Save in PST: There are two fields in this option:
e PST File Path

e PST File Name
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XI.

XII.

If you want to save the migrated items in PST file then type the PST path location in both the fields,
otherwise it will be an error.

Save in Exchange Server: There are four fields in this option:
o Exchange Server Name
o Exchange Mailbox
o Password

o Domain

If you want to save the migrated items to the user mailbox on MS Exchange Server, then all the four fields
are compulsory, otherwise it would be an error.

@ NOTE: Only one amongst “Save in PST” and “Save in Exchange Server” should be
filled, otherwise it will be an error.

e Remote Mailbox Path

Following are the mandatory fields to be filled in while using this mode:

VI.

VII.

Password: Type the password of user mailbox (if any).

Remote Mailbox Path: Browse and list the path of remote mailbox path of Novell GroupWise
account to be migrated.

Archive Details: Always type "NO" in this field if you want to migrate the mailbox items only.
Advance Options: Provide details to these fields if you are accessing the Remote mailbox from a
network computer. This section will comprise of the login details of the computer in network. There
are three fields in advanced options:

a. User Name of the network computer where mailbox is saved

b. Password of the network computer where mailbox is saved

c. Computer Name/IP of the network computer where mailbox is saved
Save in PST: There are two fields in this option:

a. PST File Path

b. PST File Name

If you want to save the migrated items in PST file then type the PST path location in both the fields,
otherwise it will be an error.

Save in Exchange Server: There are four fields in this option:
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VIII.

a. Exchange Server Name
b. Exchange Mailbox

c. Password

d. Domain

If you want to save the migrated items to the user mailbox on MS Exchange Server, then all the
four fields are compulsory, otherwise it would be an error.

= NOTE: Only one amongst “Save in PST” and “Save in Exchange Server” should be
filled, otherwise it will be an error.

e Command Line (for advanced migration)

Following are the mandatory fields to be filled in while using this mode:

VI.

VII.

VIII.

User ID: Type the user name of the mailbox.

Password: Type the password of user mailbox.

Command Line: This field is compulsory. If this field is left blank, error will be shown.
Archive Details: Always type "NO" in this field if you want to migrate the mailbox items only.
Save in PST: There are two fields in this option:

PST File Path

PST File Name

If you want to save the migrated items in PST file then type the PST path location in both the fields,
otherwise it will be an error.

Save in Exchange Server: There are four fields in this option:
Exchange Server Name

Exchange Mailbox

Password

Domain

If you want to save the migrated items to the user mailbox on MS Exchange Server, then all the
four fields are compulsory, otherwise it would be an error.

® NOTE: Only one amongst “Save in PST” and “Save in Exchange Server” should be

filled, otherwise it will be an error.
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3.2.3 Importing Excel Database

Once done with the creation of Excel (.XLS) sheet, you are ready to import the same to Kernel for Novell
GroupWise to Exchange Migration File Creator and save it as .NUCON file. Follow the given steps:

1. Launch Kernel for Novell GroupWise to Exchange Migration File Creator software.

[k Kernel for Novell GroupWise to Exchange Migration File Creator

. Ele  Edit  wiew Help

PRERE* %0 R PNOCLEDS.

Tt Cpen Sawe  Save As | Add Record Remove Help  Import Excel - DATA RECOVERY
Record Details Profile Folders/File Path
# || Mode | User Id | Password | Address | Port | [
B
Mode
User Id
Password
Address

Port
Carching Mailbox Path
Remate Mailbox Path
Command Line

=
User Mame

| £

kd

Kernel

Ready T

Figure 3.25: File Creator software

2. Click Import Excel button from the toolbar. Software displays the Open window to select the
NucleusMigrationFile (.XLS) from the saved location.
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K| Kernel for Novell GroupWise to Exchange Migration File Creator

© Fle Edit Wew Help

gD ERCN"

Mew Open Save Save As

Record Details

I

Impart Excel

%

Add Record  Remove

9

Help

Profile Folders/File Path

Properties

B Group¥ise Properties
Mode
User Id
Password
Address
Port
Caching Mailbox Path
Remote Mailbox Path
Command Line

E GroupWise Remote login

|

YU U
<
DATA RECOVERY

| Caching Mailbo, .. I Remote Mailbosx. .. | Comrand Ling |

Copy of MucleusExcelShest . xls
NucleusExceISheet.xIs

v
File name: INucIeusMigrationFiIe Open I
Filez of type: IMicrosoft E=cel [*xls] ;I Cancel |
i
b3 Save
- - l
Kernel
< |

Ready

CAP| MUM| SCRL .-

Figure 3.26: Selecting .XLS file

3. Browse and list the excel sheet. As you list the file in software, it displays a window with compilation
output for the total records scanned from the excel sheet.

K]

mode | U ser Password | Uger 1D

| Paszword

| Address

| Fort

|

® Orilire
® Caching Mail...
1y Remate Mailb..
@ Command Line
® Orilire
® Caching Mailb..
1y Remate Mailb..
® Command Line
Orilire

<

%

|

Compilation Dutput:

Total Records Scanned: 12
Total ermors found: 15
Total warnings found: 21

Description:
Record Humber: 1: 2 Error[s]. 2 WwWarning[s)

Error: Address and Port cant be left blank.
Error: User D cant be left blank

‘where: Tl No Error(s]

® Error(s) only, Mo warningls]

I ‘wiarning(s] only, Mo Ermor(s]

® Errarfz] and ‘Warninglz) both

Cancel

|

|
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Figure 3.27: Compilation Output

4. Modify the excel sheet as per the compilation output provided by the software. If there are no errors
then click OK to proceed.

Saved mailbox details get listed in the software.

K| Kernel for Novell GroupWise to Exchanpe Migration File Creator

| He Edt Vew Hep
; m = ol : ) ™ 'NUCLEUS |
o I-J, l'J “f% o | @ (@

: Mew Open  Save  SaveAs | AddRetord Remowve Help  Import Excel - DATA RECOVERY

Record Details Profile Folders,/File Path
[ | [Mode |UsuId IPo\sswud |Ftddrﬁs|Put |Cad'nq|'l'laﬂ:m( |Rﬂnnls|'ﬂ'laﬂ:m(|€m‘lwndmc |Llse¢Nam- |U9HPGS
H GroupWise Propertie Remobe Mailbox ... D:lwikasd

Mode Remote Mailox ... Dnlyikas4

Usar Id Remobe Mailbosx ... Dl Softremate

Password

Address

Poart

Caching Maibox Path

Remobe Mailbox Path

Command Line
B / w

ks
Kernel
£ *>

Roady

Figure 3.28: Listing of Mailboxes

5. Click the Save As button from the toolbar to save the listed items as .NUCON batch file at appropriate
location.

6. Launch Kernel for Novell GroupWise to Exchange Migration software- main application and select the
option to convert batch of GroupWise Mailboxes and list the .NUCON batch file for migration.

3.2.4 Using .NUCON Batch file for Multiple Mailbox Migration

Now that the .NUCON Batch file has been created, you can easily perform the multiple mailbox migration
with the help of .NUCON file. Follow the simple steps given below:

1. Launch Kernel for Novell GroupWise to Exchange software. The main window appears as
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K| Kernel for Novell GroupWise to Exchange - Ver 9.05.01 |f-—|ralﬁl
DBl Too Heb

N W 1 - VU If:
2 3 Ko Rty

Sngle Malbox BatchFile Export Help -

ﬂ Step 1:
Flease saback the
Conversion Option
Please select appropriate option
Skep Z:
Ph ct the Mode to

.
kj (2 Select this option o corwert single Groupwise Maibox:

E oy
q . i') (3) Select this option to corvest batch of Groupiwise Malboes

Ay Migrake Single GroupiWise User Maibes: or & Batch file congisting of GroupWiss User Mailbes(s) with Eeoned for Novell GroupiWiss bo Exchangs software,

@ 1. Convert Singhe GroupWwise Malbo: option helps to canvert one malborx at a time,
Z.CanhthmhufﬁfupmMnMWMbstommummmwnmﬁaatw.knfusﬁtmmtmmmkrmw
Buatch file crestion,

Sedact appropriate aphion and chok Mest bt

4 Ewit ] [ Mext

Figure 3.21: Main window

2. Select the "Select this option to convert batch of GroupWise mailboxes" radio button and click
Next button.

The "Open" window gets displayed.
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Open

Laak in: |@Desktup v| Q9 T -

E]My Dacurnents
l& '_vz My Carnpuker
by Recent ‘QMF Metwoark Places
Documents MucleusMigrationFile, nucon

Dezktop

@

by Documents

<

ty Computer

-

File name: |NucleusMigratinnFile.nuu:u:un b | [ Open l

by Metwark, | Files of bvpe: | k.ermel Exchange details[*.nucaon) w | [ Cancel ]

Figure 3.22: ‘Open’ window

3. Select the batch file of .NUCON file extension and click the "Open" button.

¥, Kernel for Movell GroupWise te Exchange - Ver 9.05.01

Fie Tool Help
[ 3 VU [
Sirgle Maibox: BaichFle  Export  Help - DATA RECOVERY
w'  Step 1=
Flease select the P b
Conversion Option
IMode User Id Password Address: Fort Caching Malbo...  Remote Malbo...  Command Line Liser Iy
. Remote Mailboe ... <Emphy s <Empty <Emphy > <Emply > <Emply» D:vkeas <Emply> <Empt:
@ stepz Remcke Malbasc .. <EMpty> <Enpty> <Empky> <Emgty> <Empty> OilCopy of vkas  <Emptys <Empt
Please seleck the Made to Remote Mailbox ... «<Empty> <Empty > <Empky> <Emphy> <Emply> D:\Copy {2) of ...  <Emply> <Empt:
eannact b GroupWise
Maiboxes
Step 3
Step 42
< td
Kernel
wvave.riucleust echnologies. com

Figure 3.23: .NUCON file listed
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4. Click the Export button to perform the migration of unlimited GroupWise mailboxes to PST or
Exchange Server.

After that the software starts the saving process and saves the converted items at the defined location.

X The saving process is same as described above in Single Mailbox Migration section.

3.2.5 Saving with Exchange Server (for multiple mailbox conversion option)

Save in Exchange Server option for multiple mailbox conversion is pre-defined while creating the batch file
of unlimited user mailboxes records in Kernel for Novell GroupWise to Exchange Migration File Creator
software. Following is the process which gets followed while saving the files in MS Exchange Server user
profiles:

1. Click the radio button ‘Select this option to convert batch of GroupWise Mailboxes’.

K| Kernel for Novell GroupWise to Exchange - Ver 9.05.01

-9 b 1 ) YL S
e & kE @ | NOCLEUS |
Snghe Malbox  Batch File  Export Help - DATA RECOVERY
a Skep I:
Please selack the

Conversion Optien
Please select appropriate option
Skep 2:

-y
'@J. (T Select this option to carvert single Groupiwise Mailboo:

Step 3:
=
w (%) Select this option to corvert batch of Groupiise Malboxes

Skep 4:

o Migrake Single Group'Wiss Liser Maiboo: or & Bateh file consisting of GroupiWise User Mailbox(s) with Eerned for Novell Group'wise to Exchangs softwars.

P

1, Comnvert Singhe GroupWWiss Malbox opton helps bo convert one malbor; at a tme,
- Cc?hﬁtmhd&ummﬁaﬁummbstommtuﬁﬂcd@mpmwwnmatatm-ﬁdamﬂmmbmwmmdmm
Batch file creation.

Sedact appropriate ophion and chick BMest bukton

Kernel

Exit I I Mext

wererd, ndeustechnolopies. com

Figure 3.29: Main Window
2. Click ‘Next’ to continue.

3. List the .NUCON file (the created batch files) with Select File button.
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Kernel
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4. Click the Export button.

Software will start saving the files in the defined Exchange Server user profiles.

Figure 3.30: Listing of .NUCON file

After successful saving, Kernel for Novell GroupWise to Exchange Server will display the "Saving
Complete" message which means that emails and other items of Novell GroupWise mailbox are saved

successfully to the User mailbox on MS Exchange Server.
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4. Advanced Options to make the Migration More
Efficient

Advanced options are provided in Kernel for Novell GroupWise to Exchange software for the user to ease
the task of email migration from Novell GroupWise to Exchange mailboxes or PST files, as per the
requirement.

4.1 Migration of Archived Emails

Kernel for Novell GroupWise to Exchange features migration of archived items of GroupWise user
mailbox(s). Activate the Show Archive checkbox from the "Migrate Archive items" section. Following two
options are provided for migration of archived items:

e Use default Archive path: This option takes the default archive file location of the default user
profile configured and opened in Novell GroupWise client.

e Specify Archive path: This option takes the file path specified by you for archived file for user
mailboxes other than the default one.

W If you have selected Login Mode(s) or Command Line mode then you should always
use Specify Archive path option to define archive file location of the user mailbox
listed in Login or Command Line fields. If Use default Archive path option is
selected, then the software will display the archived items of default user profile
configured in GroupWise for migration.

= When you opt for archive migration, software will list only the archived file items for
preview and saving. Other mailbox items are not displayed when you select to
migrate archived items.
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Figure 4.1: Select Archive Option

4.2 Migration of all Address Books

Kernel for Novell GroupWise to Exchange enables migration of all the address books at a go.

Once the .NUCON file is selected for export, software starts the process of saving. Before starting the
process, software displays the message for address book migration.

Do you want to export address book also?

Kernel for Novell GroupWise to Exchange | =

L] ": Do wou wank ko export addresshook also?
L

J[_ |

Figure 4.2: Message asking for exporting address book

=
1]
L

Click ‘Yes’ if you want to export address book, otherwise ‘No’ if you do not want to.
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4.3 Folder Selection for Batch Migration of GroupWise Mailboxes

Advanced options help you to select/deselect various options that filter your migration process.

To view and implement advance options select Advance Options from Tool menu.

Adwvance Options E|

[ ] Expart inta existing folders in Exchange M ailbos

[ ] Prompt far folder selection for each mailboy, while using batch file mode
Show all address books

[ ]Advance settings for Sent [tems

[ ] Do not save Calendar items in Calendar view

[¥]:Change the name of Groupi/ize falders while migrating to Outlook, or E xchange

Default Grouptfize Folders Grouptfize Faolders Outlaak, # Exchange Falders
b ailbox b ailbos [k
Trazh Trazh Deleted ltems
whork [n Progress Work [n Progress Drrafts
Checklizt Checklist Tazks
< >
[ Ilze Default ] [ Apply
k. ] [ Cancel ]

Figure 4.3: Advance Options
4.3.1 Exportinto existing folders in Exchange Mailbox

Select this option, if you want to save the migrated items into existing folders of MS Exchange Server user
mailbox.

X In case of migrating items from orphan GroupWise folders: for any folder which
exists in GroupWise mailbox but does not exist in the Exchange server mailbox,
software will create a new folder of its original name in Exchange mailbox and export

items to that folder.
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4.3.2 Prompt for folder selection for each mailbox, while using batch file mode

Software enables you to select desired folders for saving during batch file migration process. You can
select appropriate folders for saving while performing migration with Kernel batch file of multiple mailboxes
at once.

Folder Selection

Pleaze zelect desired folderz)

| Folder Mame ||

Al AddressBook Contactsh

Trazh®,

$3$8Cabinet\E-mail from Dutlook Exprezs-importedtOutboxtOutbost,
£$$5CabinethE-rmail fram Dutlook, E spress-impartediOutbost,

£33 Cabinet\E-mail from Outlook Exprezs-importedinbost,
$£3$Cabinet\E-mail from Outlook E=press-imported\Draftz!,
$$48Cabinet\E-mail from Dutlook, Exprezs-importedtDeleted [tems',
£5$5CabinethE-mail from Outlook E xpress-imported',

$£$$ CabinetyMew Folder,

by

BRFILE, (T, LY, (LY O SRR N N [N paty [ B gy b1 N

£ *

[ ] Mever show this dislog again and save all folders

| ok | [ Cancel

Figure 4.4: ‘Folder Selection’ window

The Folder Selection window appears during the batch migration process, when Prompt for folder
selection for each mailbox, while using batch file mode checkbox is selected. From this window, you
can select the folders to save. If you do not want this dialog box to appear again and again, select the
Never show this dialog again and save all folders or deselect the "Prompt for folder selection for each
mailbox, while using batch file mode checkbox” from Advance Options. By this all the folders which exist in
the mailbox will get saved automatically and software will not prompt you to select or deselect the folders.

4.3.3 Show all Address Books

Select this checkbox to view all the address books of GroupWise mailbox during mailbox preview before
saving the items.

4.3.4 Advance Settings for Sent Items

Select this checkbox to activate advance settings for Sent Items conversion. If in case, the Sent Items
folder emails are listed and converted slowly, then select this option to make it fast. Kernel for Novell
GroupWise to Exchange software speeds-up the migration process with this option.
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©Nucleus Data Recovery.Com Private Limited GroupWise o Exchange



4.3.5 Do not save Calendar items in Calendar view

Select this checkbox to save the migrated calendar items in list view in MS Outlook instead of the default
calendar view.

4.4 Modifying GroupWise Folder Names as per Outlook/Exchange

You can change the folder names of GroupWise mailbox while migrating to MS Outlook or MS Exchange
Server.

Advance Options ﬁ|

[ ] Export inta existing folders in Exchange M ailbox

[ ] Prompt far folder selection for each mailbox, while using batch file mode
Show all address books

[]&dvance settings for Sent ltems

[ ] Do not save Calendar items in Calendar visw

[¥]iChange the name of Group'wise folders while migrating to Outlook, or E schangs:

Drefault Grouptsfize Folders Groupttfize Folders Cutlook, # Exchange Folders
b ailbroe: M il Tglalat™
Trazh Trazh Deleted [tems
whork [n Progress Work [n Progress Dirafts
Checklizt Checklist Tazks
< >
[ Use Default ] [ Apply
(] ] [ Cancel ]

Figure 4.5: Modifying GroupWise Folder Names

Select the checkbox “Change name of GroupWise folders while migrating to Outlook or Exchange”
to activate the section where Default GroupWise Folders name, GroupWise folders and Outlook/Exchange
Folders are listed. From here you can easily modify the folder names of GroupWise mailbox and MS

Outlook/MS Exchange Server mailboxes for migration. After that click Apply button and then OK button.

This option is supportive to Unicode language folder migration.
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5. Difference between Evaluation and Full Version

The free to download Evaluation version of Kernel for Novell GroupWise to Exchange is fully functional in
its conversion capabilities.

It converts your Novell GroupWise mailboxes and saves them in PST file or in MS Exchange Server
mailbox. The demo version shows complete preview of the converted emails with data but will save only
first 10 emails per folder existing in the User Mailbox to PST or MS Exchange Server.

Purchasing the Full version delimits the saving restrictions and saves as many user mailboxes as required
by the user.
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6. Purchase and Support

6.1 Purchase Kernel for Novell GroupWise to Exchange

You must purchase Kernel for Novell GroupWise to Exchange software in order to save entire converted
email messages of Novell GroupWise mailboxes. The free evaluation version of Kernel for Novell
GroupWise to Exchange software lets you save 10 emails per folder of the converted GroupWise mailbox.
You can purchase the Kernel software through Nucleus Data Recovery website:

http://www.nucleustechnologies.com/buy-groupwise-to-exchange.php (encrypted and secure site)

Payment and Delivery

Purchase the Kernel software with our authorized resellers which provide number of payment options for
your ease - Paypal, FAX, Credit Card, E-cheque, Pay Order etc. For other methods, please email us to
sales@nucleustechnologies.com

After making the purchase transaction with our resellers, we send you an email which consists of
activation details and download link of the full version comprising of activation code. This email is sent to
the mail address which you have used while processing the purchase transaction with our resellers.

X Important: It is advised to avoid using false email address while making the
purchase transaction.

6.2 Support Options for Kernel for Novell GroupWise to Exchange

Web Support
Online Help:

If you have queries relating to the use of Kernel for Novell GroupWise to Exchange software, you can visit
our online help to have some more clarification to the usage of the software.

Online Help: http://www.nucleustechnologies.com/Online-Helps.html

Knowledgebase:
There is extensive knowledgebase which deals with common queries relating to the software:

Visit knowledgebase: http://www.nucleustechnologies.com/supportdesk/

Chat Support:

You can also get the help of our experts online by visiting our chat support section. You can communicate
directly to our experts online.

Chat Support: http://www.nucleustechnologies.com/Support.html
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Telephone Support

Helpline:

+91-9818725861

1-866-348-7872 (Toll Free USA/CANADA)
Email Support

For Sales: sales@nucleustechnologies.com

For Support: support@nucleustechnologies.com

For General Queries: contact@nucleustechnologies.com

Kernel (;,1/
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/. Legal Notices

This section comprises the legal specification about Kernel for Novell GroupWise to Exchange and the
company NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED

7.1 Copyright

NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, Nucleus Kernel accompanied user manual and
documentation are copyright of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, with all rights
reserved. Under the copyright laws, this user manual cannot be reproduced in any form without the prior
written permission of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. No Patent Liability is
assumed, however, with respect to the use of the information contained herein.

© NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. All rights reserved.
7.2 Trademark

Nucleus Kernel ® is a copyright work of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000
Advanced Server®, Windows 2003 Server®, Windows XP®, MS Outlook, MS-DOS, MS Office, MS
Exchange Server and Novell GroupWise Client and Novell GroupWise Server are registered trademarks
of Microsoft Corporation and Novell Inc.

All other brand and product names are trademarks or registered trademarks of their respective
companies.

7.3 Disclaimer

The Information contained in this manual, including but not limited to any product specifications, is subject
to change without notice. NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED provides no warranty
with regard to this manual or any other information contained herein and here by expressly disclaims any
implied warranties of merchantability or fithess for any particular purpose with regard to any of the
foregoing NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED assumes no liability for any damages
incurred directly or indirectly from any technical or typographical errors or omissions contained herein or
for discrepancies between the product and the manual. In no event shall NUCLEUS DATA
RECOVERY.COM PRIVATE LIMITED, be liable for any incidental, consequential special, or exemplary
damages, whether based on tort, contract or otherwise, arising out of or in connection with this manual or
any other information contained herein or the use there of.

7.4 License Agreement

Kernel for Novell GroupWise to Exchange software is Copyright work of NUCLEUS DATA
RECOVERY.COM PRIVATE LIMITED

Your Agreement to this License
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You should carefully read the following terms and conditions before using, installing or distributing this
software, unless you have a different license agreement signed by NUCLEUS DATA RECOVERY.COM
PRIVATE LIMITED. The terms and conditions of this License describe the permitted use and users of
each Licensed Copy of Kernel for Novell GroupWise to Exchange software. For purposes of this License,
if you have a valid license, you have the right to use a single Licensed Copy of Nucleus Kernel.

Scope of License

Each Licensed Copy of Kernel for Novell GroupWise to Exchange software may either be used by a single
person or used non-simultaneously by multiple people who use the software personally installed on a
single workstation. All rights of any kind in Nucleus Kernel, which are not expressly granted in this
License, are entirely and exclusively reserved to and by NUCLEUS DATA RECOVERY.COM PRIVATE
LIMITED. You may not rent, lease, modify, translate, reverse engineer, decompile, disassemble, or create
derivative works based on, Nucleus Kernel, nor permit anyone else to do so. You may not make access to
Nucleus Kernel available to others in connection with a service bureau, application service provider, or
similar business, nor permit anyone else to do so.

Warranty Disclaimers and Liability Limitations

Kernel for Novell GroupWise to Exchange software, and any and all accompanying software, files, data
and materials, are distributed and provided as is and with no warranties of any kind, whether expressed or
implied. In particular, there is no warranty for the quality of data recovered. You acknowledge that good
data processing procedure dictates that any program, including Nucleus Kernel, must be thoroughly tested
with non-critical data before there is any reliance on it, and you hereby assume the entire risk of all use of
the copies of Nucleus Kernel covered by this License. This disclaimer of warranty constitutes an essential
part of this License. In addition, in no event does NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED
authorize you or anyone else to use Kernel for Novell GroupWise to Exchange software in applications or
systems where Kernel for Novell GroupWise to Exchange software failure to perform can reasonably be
expected to result in a significant physical injury, or in loss of life. Any such use is entirely at your own risk,
and you agree to hold NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED harmless from any and all
claims or losses relating to such unauthorized use.

General

This License is the complete statement of the agreement between the parties on the subject matter, and
merges and supersedes all other or prior understandings, purchase orders, agreements and
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises,
obligations or representations made by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED herein.
Any waiver by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED of any violation of this License by
you shall not constitute, nor contribute to, a waiver by Nucleus Data Recovery of any other or future
violation of the same provision, or any other provision, of this License.
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